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Configuration Manual

How to Run R-Program for the survey file.
1) Install the packages by running the program.

2) Call the functions from the library by running the code.

3) Read the file “Book1.xlsx” through the R program. Depending on where you keep it on

your computer, you'll need to adjust the source address.
Example: - | have saved the excel file in the “E” drive and under the “MSC FinTech”
folder, and under that “Final Project” and subfolder “1” and the excel file name is

“Bookl1.xIsx”.

10 rohit <- read_excel("E:/MSC FinTech/Final Project/1/Bookl.x15x")

b
]

4) Continue to run the program, for checking the missing values and deleting/replacing them.
In the below image we can see the data and choose the column such as ID, Start,
completion, email, gender, etc. is taken off since those columns are not useful for our

analysis.

RStudio

Eile Edit Code View Plots Session Build Debug Profile Tools Help

@ - Of - Go to file/function ~ Adaing ¥

rohit resut © @] correlation RR
D Start completion  email gend o mployment ty

1 onymous | F Karnatak
2 Hyderabad
3 ancnymous | Male Miraj
4 anonymous | Male Fune
5 anonymous  Female <30 | Unempioyed geigaum
6 anonymous | Male 3140 | Salaried Employee Beigaum
7 ancnymous | Male <30 | Unemployed Beigaum
8 2022-06-12 | 2022-06-12 anonymous | Male 31<40  Szlared Employee Bangalore

Showing 110 8 of 195 entries, 21 total columns

Console  Terminal Jobs

R R4.1.1 - E/MSC FinTech/Final Project/1/

> library(readxl)

warning message:

package ‘readx]’ was built under R version 4.1.2
» Tibr -

2’ was built under R version 4.1.3
excel ("E:/MsC FinTech/Final project/1/Bookl.x1sx")

v
poli

Environment  History  Connections  Tutorial

Rl project: (Noi

g # Import Dataset - | &) 167 MiB - st =

R ~ | @k Global Environment ~

Data

result num [1:11, 1:117 1 0.2245 0.4107 0.3868 -0..
rohit 195 obs. of 21 variables

values

drops chr [1:10] "ID" "start” "completion” “email”.

Files Plots Packages Help

5 Export v

Vie

wer



5) Since the data has initial unwanted survey columns which will not be useful for correlation,
the program is written such that those columns are deleted. Only relevant columns are kept
to analyze, which can be seen in the below image.

RStudio -
File Edit Code View DPlots Session Build Debug Profile Tools Help
LR+ SIS 2 - Go to file/function ~ Addins = R Project: (Noi
rohit result © | @ comelation RR. — [  Envionment History Connections Tutorial —_
Fiiter Tl # Import Dataset + | W) 16TME + List ~
= enhance stri R~ | fh Global Environment ~
the Improve increase carryi 2w
awareness  government  securily m:”“" costs Tor accept dp:fieallu percent o i Da::smt num [1:11, 1:11] 1 0.2245 0.4107 0. 3868 -0.
policies of offinancial ~ an cumency financial mis : i1, 1 o - 4107 0. -
financial transactions individual transactions the rohit 195 obs. of 11 variables
activities P yalues
1 1 1 2 1 4 1 2 3 2 drops chr [1:10] "10" "start” "completion” "email".
2 2 2 2 2 3 2 2 4 2
3 1 1 1 1 3 2 3 3 2
4 1 1 3 1 4 1 3 2 2
5 5 5 5 5 5 5 5 5 5 Files Plots Packages Help  Viewer —_
6 1 3 1 1 3 2 1 3 1 = Export -
7 2 2 2 3 3 1 2 1 2
8 4 1 4 2 2 3 3 1 5.
»
Shawing 1 to 8 of 195 entries, 11 total columns
Console  Terminal = Jobs =0

R R41

> rohit <- rohit[ ,-c(1,2,3,4,5,6,7,8)]
> drops <- c("ID","start”, "completion™,"email”, "gender”,"age"”,"employment”, "city”, "mode"”, "typ
e”)

> rohit$Ip <- rohit§start <- rohitScompletion <- rohitSemail <- rohit$gender<- rohitSage <- ro
hitSemployment <- rohitScity <- rohit$mode <- rohitStype <- NULL

> View(rohit)

=

6) Once those columns are deleted Correlation results are viewed and the graph is plotted.

View(rohit)

head (rohit)|

result = cor(rohit)

View(result)

corrplot(cor(result),tl.col = "black”™, tl.srt = 90, sig.level = 0.05)



7) The graph corrplot is plotted and the image can be imported to the report for further analysis

of correlation.

RStudio
File Edit Code Miew Plots Session Build Debug Profile Jools Help
O -opla- G ~ Addins ~
rohit resuit % | @] comelation RR =0
SourceonSave | @ A - +run | >+ Source -

5 ary
6 ary(readx1)

7 Tibrary(corrplot)

8 Tibrary(ggplot2)

9

10 rohit = read_excel("
11 view(rohit)

12 sum(is.na(rohit))

12 colsums(is.na(rohit))
14 rohit[!(rowsums(x = is.na(x = rohit)) = ncol(x = rohit)),]
15 rohit <- rohit[ ,-c(1,2,3,4,5,6,7,8)]

16 drops <- c("ID","start”, completion”, "email
7 rohitSIp <- rohit$start <- rohitscompletion
18 view(rohit)

19 head (rohit)

20 result = cor(rohit)

21 view(result)

22 corrplot(cor(result),tl.col =

E:/MSC FinTech/Final Project/1/Bookl.x1sx")

,"gender”,"age", "employment"”,"city", "mode", "ty
<- rohitsemail <- rohitigender<- rohitsage <-

“black”, tl.srt - 90, sig.level - 0.05)

23
24
»
1| (Top Level) + R Script &
Console  Terminal Jobs =0
R R4.1.1 - EYMSC FinTech/Final Project/1/
3 2 o

> result = cor(rohit)
> View(result)

> corrplot (cor(result),tl.col =
warning message:

In corrplot(cor(result), tl.col = "black”, tl.srt = 90, sig.level = 0.05) :

Not been able to calculate text margin, please try again with a clean new empty window using
{plot.new(); dev.off()} or reduce tl.cex

>

“black”, tl.srt = 90, sig.level = 0.05)

Xl project: (N

Environment  History  Connections  Tutorial =

2> O esmis - |

#* Import Dataset ~ List =

R = | ik Global Environment ~

pata
result num [1:11, 1:11] 1 0.2245 0.4107 0.3868 -0..
Drohit 195 obs. of 11 variables
values
drops chr [1:10] "ID" “"sStart” "completion” "email”
Files Plots Packages Help Viewer =
A zoom | Zexport + (O | <3 Publish =

strict lawsRIF RS,




How to get results on SPSS:-

1) Importing the survey data set into SPSS. Click on the File > Open > Data.

Eile Edit View Data Transform Analyze Graphs Utilities

New ' b =B
Open ' | @ Data..
Import Data " | Einternet Data
[y @ Syntax_..
= & Output._.
Save As... @ Script...

2) In “Files of type” select “Excel” to the data type and select “Survey-195” and then open
the file. The “Read the Excel File” window will appear. Select “Tick” the options
mentioned below on the screenshot, like “Read the variable names from the first row of
data, and percentage of values and ignore hidden rows and columns”. Lastly, click “Ok”

B

File Edit View Data Transform Analyze Graphs Utilities Extensions Window Help

e DevBL=ZB A BEE JQEQ

14 - @ Read Excel File *

war var var var var war

E:\WMSC FinTech'\Final Project\Survey-195 xlsx

Worksheet: Sheet1 [A1:V196] vi

Range: | ‘

Read variable names from first row of data

. Percentage of values that determine data type:

8 [~ lgnore hidden rows and columns

9

10 "] Remove leading spaces from string values

11 ] Remove trailing spaces from string values

12 Preview

13

i &0 Starttime ¢2 Compl_. g4 Email

= 1 1 06/12/2022 06/12/2022 Janonymous . ~
- 2 2 06/12/2022 06/12/2022 anonymous .
16 3 3 06/12/2022 06/12/2022 anonymous .

17 4 4 06/M12/2022 06/12/2022 anonymous .

18 5 5 06/M12/2022 06/12/2022 anonymous .

= 6 6 06/M12/2022 06/12/2022 anonymous .

7 7 06/12/2022 106/12/2022 'anonvmous | ¥

20 < >

21

22 Final data type is based on all data and can be different from

23 the preview, which is based on the first 200 data rows. The

ﬁ; preview displays only the first 500 columns._

st

25

( | Paste || Reset ||Cance|” Help | 3

_ LY




3) Verify that all of the data is being imported from the Excel sheet once the data set is shown
in the Data View sheet. In order to do the analysis, we need the data to be in numeric values
so that the software can analyze the data set. Since | had taken up the survey, and the
answers received were in “String”, it needed to be changed. By the data type in the
“Variable View” sheet by using the Transformation tool and by changing the measure to
“Scale”

@ *Untitled2 [DataSet1] - IBM SPSS Statistics Data Editor
File Edit View Data Transform Analyze Graphs Utilities Extensions Window Help

BHEEe~Fhil i BE S0

Name Decimals Label Values  Missing

1 ID Numeric 3 0 None None
2  Starttime Date 40 0 Starttime None None
3  Completiontime Date 40 0 Completion ti... None None
4 Email String 9 0 None None
5 Name Numeric 8 2 None None
6  Whatisyourgender String 6 0 Whatis your ... None None
7  Whatisyouragegroup String 10 0 Whatis your... None None
8  Pleasestateyouremploymentstatus String 28 0 Please state ... None None
9 Inindiawhichcitydoyoubelongto String 42 0 In India, whic... None None
10 Doyouagreethatpeople'sawarenesscancont.. String 17 0 Do you agree... None None
11 Doyouthinkthatgovernmentpoliciescanimpa... String 17 0 Do you think t.. None None
12  Doyouagreethattheintroductionofdigitalcurre... String 17 0 Do you agree... None None
13 Doyouagreethattheuseofdigitalcurrencyinind... s.hg 17 0 Do you agree... None None
14  Doyouthinkthatthelaunchofdigitalcurrencyca... String 17 0 Do you thinkt.. None None
15 Howdoyouthinkthatthepeopleofindiawillacce... String 10 0 How doyout.. None None
16  Howdoyouthinksmalltownsinindiawiliperceiv... String 10 0 How doyout.. None None
17  Whatpercentageofpaymentsdoyoucurrently.. String 4 0 What percent.. None None
18 Howsafedoyouthinkdigitalcurrencywouldbef... String 9 0 How safe do ... None None
19  Doyouthinkthegovernmentshouldmakestrictl.,. String 17 0 Do you think t... None None
20 Howimportantitistoadoptthedigitalcurrencyfo... String 14 0 Howimporta.. None None
21 Whichmodeofpaymentdoyouprefertopaythe... String 14 0 Which mode ... None None
22  IfcashwhyEginvasionofprivacyavoidingdigital... String 216 0 If cash why? ... None None
23

24

25

26

Data View Variable View



4) On the toolbar we have “Transform”, and under that, we have “Recode into Different
Variables” this will help us to convert the survey variable from string to numeric.

G-\ *Untitled3 [DataSet3] - IBM SPSS Statistics Data Editor

File Edit View Data Transform Analyze Graphs Utilities Extensions Window  Help
g Compute Variable... E ﬂ Al R II‘ O\
B s 04 D
o [E5 Programmability Transformation. ..
f In] Sta E Count Values within Cases... Whal Whatisyo 6, Pleasestateyouremployl
Shift Values. . | isyo g uragegro ¥4 us
urge.. up

1 1| 12-Jur B Recode into Same Variables . male |31 =40 Salaried Employee

2 2 A12-Jur E Recode into Different Variables... e <30 Salaried Employee

3 3 12-Jur o X ile =30 Salaried Employee
4 a| 12y ] Automatic Recode... le  31<40 Salaried Employee
5 5 12-Jur E Create Dummy Variables male =30 Unemployed

G 6 12-Jur H’E Visual Binning... e 31 =40 Salaried Employee

7 7 12-Jur . o ile =30 Unemployed

8 8 12-Jur e Optimal Binning. .. le  31<40 Salaried Employee

g 9 42-Jur Prepare Data for Modeling > e =30 Unemployed

10 100 A12-Jur ﬁRanl-_( Cases._ ile 31 =40 Salaried Employee
hh 11 12-Jur e =30 Salaried Employee
12 12 12-yur [ Date and Time Wizard... le <30 Salaried Emplayee
13 13 12-Jur E Create Time Series e 31 =40 Self-employed

14 14 A2-Jur %E Replace Missing Values... e 31 =40 Salaried Employee
15 15 12-Jur e =30 Salaried Employee
16 15 12-Ju @ Random Number Generators... le  31<40 Salaried Employee
17 17 12-dur [ § ile 31 =40 Salaried Employee
12 1a e Ty (T Ty e e nwaala =N Qalariad Emnlnvaa

5) Once the Recode window opens, select the variable in which the values need to be replaced,
and change the output variable name to a suitable name.

File Edit View Data Transform Analyze Graphs  Utilities Extensions Window  Hel
ly: p p
HE I EEFIAEE ol Q
He& - ] = @
1:1D 1
f [n] gﬁ Starttime &ﬁ Completio Qa Email &, MName What ‘Whatisyo 9 Pleasestateyouremploymentstat Qa Inindiawhichcitydoyoubelon
ntime Ja isyo g uragegro 99 us
urge.. up
L 4] 12-Jun-2022  12-Jun-2022/an0MYMOU3 iy pecode into Different Variables X
2 2 42-Jun-2022  12-Jun-2022 anonymou
j j :z’jun’igzz :Z’jun’iﬁzz anonymou String Variable -> Output Variable: Output Variable
-Jun- -Jun- anonymou ~ -
£ D Doyouagreethatpeople sawarenessc. .. Name:

5 5 A12-Jun-2022  12-Jun-2022 anonymou ﬁ Start time [Start.__
[ 6 12-Jun-2022  12-Jun-2022 anonymou ﬁ Completion tim___
7 7 12-Jun-2022  12-Jun-2022 anonymou & Email Label-
8 B 12Jun2022  12-Jun-2022 aNONYMOUS & ame
9 9  42-Jun-2022  12-Jun-2022 anonymou &What is your ge___
10 100 12-Jun-2022  12-Jun-2022 anonymou &4 What is your ag.__
11 11 12-0un-2022  12-Jun-2022 anonymou & Please state yo
12 12 12-Jun-2022  12-Jun-2022 anonymou & In India. which ¢
13 13 12-0un-2022  12-Jun-2022 anonymou & Do you think th
14 14 12-0un-2022  12-Jun-2022 anonymou & Do you agree th
15 15 12-Jun-2022  12-Jun-2022 anonymou d and New Values

¥ &4 Do you agree th._.
16 16 12-Jun-2022  12-Jun-2022 anonymou 9 D .

4 Do you think th... 3 3 =5

17 17 12-0un-2022 12-Jun-2022 ROMYMOUS & Liomn. e e st (Cptonalliaseiaslsctimlcondtion)
18 18 12-Jun-2022  12-Jun-2022 anonymou -‘ Dasts ‘ ‘ Reosat HCHHEE||| Help |
19 19 12-Jun-2022  12-Jun-2022 anonymou — —
20 20 12-Jun-2022  12-Jun-2022 anonymous Male 31 =40 Salaried Employee Bangalore
21 21 12-Jun-2022 12-Jun-2022 anonymous . Male =30 Self-employed Gangavathi
22 22 12-Jun-2022 12-Jun-2022 anonymous . Male =30 Employed for an hourly wage. Belgaum
23 23  12-Jun-2022 12-Jun-2022 anonymous . Female <30 Salaried Employee Bangalore
24 24  12-Jun-2022  12-Jun-2022 anonymous . Male 31 =40 Salaried Employee Banglore

<

Data View Variable View



6) Click on “Old and New Value” to do custom changes of values in the required order instead
of the lowest value or highest value. Since the survey has 5 options to choose between, the
string values are replaced according to the survey sequence. In the below image we can see
that “Strongly Agree” is “1” and “Strongly Disagree” is replaced by “5”. This needs to be
manually added one by one and then click on “Continue”.

Eile Data Transform  Analyze Graphs  Utilities Extensions Window Hel
N~ Bl A B
o= Aa B g
1:1D 1
&’ D gﬁ Staritime ﬁ Completio fa Email &3 Name Whal Whatisyo Pa Pleasestateyouremploymentstat & Inindiawhichcitydoyoubelong
ntime = Q
@ Recode inte Different Variables: Old and New Values X
1 1 12-Jun-2022  12-Jun-2022 anor
2 2 12-Jun-2022  12-Jun-2022 anory  Old Value New Value
3 3 12-Jun-2022  12-Jun-2022 anor @ Value: @ Value: |1
4 4 12-Jun-2022  12-Jun-2022 anor |Stmngly Agree o]
5 5 12-Jun-2022  12-Jun-2022 anor
5 6 12Jun2022 12Jun2022 anor] O OETyiEE)
7 7 12-Jun-2022] 12-Jun-2022 anorf O System- or user-missing i
8 8 12-Jun-2022 12Jun-2022 anofp @ =z
9 9 12-Jun-2022] 12-Jun-2022 anor] [Strongly Agree 1
10 10| 12-Jun-2022]  12-Jun-2022 anor] o |Aaee —>2
1 11 120un-2022 12-Jun-2022 anor o |MNeutral >3
12 12 12-Jun-2022 12-Jun-2022 anon Disagree’ >
13 13 12-Jun-2022 12-Jun-2022 anon @ Strongly Disagree’ %
14 14 12-Jun-2022  12-Jun-2022 anon
15 15 12-Jun-2022  12-Jun-2022 anon ©
O
13 18] 12-Jun-2022  12-Jun-2022 anori O All pther values D
19 19 12-Jun-2022  12-Jun-2022 anon
20 200 12-Jun-2022  12-Jun-2022 anon
21 21 12-Jun-2022 12-Jun-2022 anonyrmow e T EIFETTpIUyED n

7) In the below image we can see that a new column has been created wherein all the string
variables have been converted to numeric from 1-5 as per our requirement.

+\,|J *Untitled3 [DataSet3] - IBM SPSS Statistics Data Editor
FEile Edit VMiew Data Transform Analyze Graphs  Utilities Extensions Window Help
A

He e~ R®LELITHAEFT 106 Q

1: awareness 1
&5 Name Whal  Whatisyo & Pleasestateyouremploymentstat &a Inindiawhichcitydoyoubelongto Doyouagreethalpe ga awareness L
&4 isyo gy uragegro ¥@ us &4 ople'sawarenessc da ®
urge.. up ancontributetothes.. nil
1 Female 31 <40 Salaried Employee Karnataka Strongly Agree Stron
2 . Male =30 Salaried Employee Hyderabad Agree 2 Agree
3 . Male =30 Salaried Employee Miraj Strongly Agree 1 Stron:
4 .Male  31<40 Salaried Employee Pune Strongly Agree 1 Stron
5 Female =30 Unemployed Belgaum Agree 2 Agree
(] . Male 31 =40 Salaried Employee Belgaum Strongly Agree 1 Neutr
7 . Male =30 Unemployed Belgaum Agree 2 Agree
8 Male 31 =40 Salaried Employee Bangalore Disagree 4 Stron
9 Male =30 Unemployed Belgaum Strongly Agree 1 Agree
10 . Male  31=40 Salaried Employee Belgaum Strongly Agree 1 Agree
" . Male =30 Salaried Employee Belgaum Agree 2 Agree
12 Male =30 Salaried Employee Punjab Agree 2 Stron
13 . Male 31 =40 Self-employed Pune Meutral =) Stron
14 . Male  31=40 Salaried Employee Pune Agree 2 Agree
15 .Male =30 Salaried Employee Amravati Strongly Agree 1 Stron
16 Male 31 =40 Salaried Employee Mashik Strongly Agree 1 Strom
17 . Male 31 =40 Salaried Employee Dharwad Strongly Agree 1 Agree
18 . Male =30 Salaried Employee Indare Strongly Agree 1 Stron;
19 Male =30 Salaried Employee Mumbai Strongly Agree 1 Agree
20 Male 31 =40 Salaried Employee Bangalore Agree 2 Strom
21 . Male =30 Self-employed Gangavathi Agree 2 Agree
22 . Male =30 Employed for an hourly wage. Belgaum Agree 2 Agree
23 Female <30 Salaried Employee Bangalore Strongly Agree 1 Agree
24 . Male 31 =40 Salaried Employee Banglore Meutral =) MNeutr



8) Once the data has been transformed to numeric values, we need to change the “Measure”
to “Scale” in the variable view.

ﬁ-\ *Rohit_SP55.sav [DataSet1] - IBM SPSS Statistics Data Editor

FEile Edit View Data Transform Analyze Graphs  Utilities Extensions Window Help
M i i B
HES I e L= A BT 1@ Q

MName Type Width ~ Decimals Label Values Missing  Columns Align Measure Role
1 1D Numeric 12 0 None MNone 12 Right & Scale N Input
2 Starttime Date hhl 0 Starttime Mone None 1" Right é) Scale N Input
3 Completion.. Date 1 1] Completion time MNone MNone 1 Right é) Scale “ Input
4 Email string 9 0 Mone MNone g Left &% Nominal “w Input
5 Whatisyour... String 6 1] What is your ge... None MNone ] Left &; Mominal “ Input
6  Whatisyour... String 10 0 VWhatis your ag... None MNone 10 Left &> Nominal “ Input
7 Pleasestate... String 28 0 Please state yo... None None 28 Left &; Mominal N Input
8 Inindiawhic... String 42 1] In India, which ... MNone MNone 42 Left &; Mominal “ Input
9 | Doyouagre... Mumeric 17 0 Doyou agreet.. None None 17 Right & Scale ~ i Input
10  Doyouthinkt... Numeric 17 1] Do you think th... MNone MNone 17 Right &Scale “ Input
11 Doyouagre.. Mumeric 17 0 Doyou agreet.. None MNone 17 Right il ordinal S Input
12  Doyouagre... Mumeric 17 0 Do you agreet.. Mone None 17 Right & Mominal “ Input
13 Doyouthinkt .. Mumeric 7 1] Do you thinkth.. None MNone 17 Right é) Scale “ Input
14 Howdoyout.. MNumeric 10 0 How do you thi... None None 10 Right & Scale “ Input
15  Howdoyout.. Numeric 10 1] How do you thi... Mone MNone 10 Right é’ Scale “ Input
16  VWhatpercen... Numeric 4 0 VWhat percenta... MNone MNone 4 Right & Scale “ Input
17  Howsafedo... Mumeric 9 0 How safe do yo... None None g Right é) Scale N Input
18  Doyouthinkt .. Mumeric 7 1] Do you thinkth.. None MNone 17 Right é) Scale “ Input
19 Howimport.. MNumeric 14 0 How important ... None None 14 Right & Scale “ Input
20 Whichmeode... Numeric 14 1] Which mode of.. Mone MNone 14 Right g? Scale “w Input
21 IfcashwhyE... String 216 0 If cash why? E... None MNone 50 Left %Nomlna\ N Input

9) Regression 1: - In order to perform the regression on the survey data, we need to click on
“Analyze” on the toolbar, select “Regression” and click on “Linear”

ﬁ-\ Rehit_SPSS.sav [DataSet1] - IBM SPSS Statistics Data Editor

Analyze

Graphs  Utilities
Power Analysis
Meta Analysis
Reports

Descriptive Statistics
Bayesian Statistics
Tables

Compare Means
General Linear Model
Generalized Linear Models
Mixed Models
Correlate

Regression

Loglinear

Neural Networks
Classify

Dimension Reduction
Scale

Monparametric Tests
Forecasting

Survival

Multiple Response

12-) 2] Missing Value Analysis. .

File Edit View Data Transform
_ =N
1:1D 1

& Starttime Ct
1 1 12-Jun-2022 12-J
2 2 12-Jun-2022 12-J
3 3 12-Jun-2022 12-J
4 4 12-Jun-2022 12-J
5 5 12-Jun-2022 12-J
6 6 12-Jun-2022 12-J
7 7 12-Jun-2022 12-J
8 g 12-Jun-2022 12-J
9 9  12-Jun-2022 12-J
10 10 12-Jun-2022 12-J
hh 11 12-Jun-2022  12-)
12 12 12-Jun-2022  12-J
13 13 12-Jun-2022| 12-J
14 14 12-Jun-2022  12-)
15 15 12-Jun-2022  12-)
16 16 12-Jun-2022) 12-J
17 17 12-Jun-2022) 12-J
18 18 12-Jun-2022  12-J
19 19 12-Jun-2022  12-J
20 200 12-Jun-2022) 12-J
pal 21 12-Jun-2022  12-J
22 22 12-Jun-2022
23 23 12-Jun-2022| 12-J
24 24 12-Jun-2022) 12-J

<
Variable View

Data View

Multiple Imputation

Complex Samples

B simulation. .

Quality Control

Extensions

hd

Window

Help

) Pleasestateyouremploymentstat
a

us

alaried Employee
alaried Employee
alaried Employee
alaried Employee
nemployed

alaried Employee
nemployed

alaried Employee

[& Automatic Linear Modeling. ..
Linear...

& Curve Estimation

Partial Least Squares...

[Ed Binary Logistic

E Multinomial Logistic...

[ Ordinal

I Probit....

[ Monlinear

[l Weight Estimation...

2-Stage Least Squares...
5 Quantile. .

&4 Inindiawhichcitydoyor

Karnataka
Hyderabad
Miraj
Pune
Belgaum
Belgaum
Belgaum
Bangalore
aum

1bai
Jalore
gavathi
aum
Jalore
Jlore

Optimal Scaling (CATREG). ..

I Kemel Ridge...

10



10)In the “Linear Regression” window, we need to select the dependent variable and
independent variables as per our research analysis. In our case, the dependent variable is
“Percentage of payments” and independent variables are ‘“People’s Awareness”,
“Government policies”, “Enhancement of security”, “Speed of transaction” and “Increase
costs” have been chosen as the 1% part of the analysis.

b

File Edit View Data Transform  Analyze Graphs Utilities Extensions Window Help

HeMe~ELIF A BE

1 : Doyouagreethatpe . |1 Visible: 21 of 21
ID £ Starttime Comuletio &4 Email \Whal Whatisvo ; mplovmentstat dh i 1ato Dovouaareethatne Dovouthi |
#3 Linear Regressicn x I'
< Dependent:
2 R T = - - .
&4 Email & What percentage of payments do you currently make with digital money? [Whatpercen_ .
3 a
4 &4 What is your gender? [Whatisyourgender] Block 1 0f 1
5 &4 What is your age group? [Whatisyouragegroup] Previous
5 &4 Please state your employ status? [Pl ourempl atus] -
7 & In India, which city do you belong to? [Inindiawhichcitydoyoubelongta] Independent(s)-
£ . ¢ Do you agree that people’s awareness can contribute to the success of the launch o... ~
8 0 you agree that people’s awareness can contribute to the success of the . )
& & Do you think that govermment policies can impact the launch of digital currency in In..
g Do you think that government policies can impact the launch of digital curre...
& Do you agree that the introduction of digital currency in India can enhance the securi.. «

& Do you agree that the introduction of digital currency in India can enhance t._.

13 ‘&' Do you agree that the use of digital currency in India can improve the spee._ | Method: Enter -

12 & Do you think that the launch of digital currency can increase costs for an in...

13 7 How do you think that the people of India will accept digital currency? [Ho... Selection Variable:

14 & How do you think small towns in India will perceive digital currency? [Howd... B Rule

15 & How safe do you think digital currency would be for carrying out financial tr..

16 & Do 'you think the government should make strict laws for people misusing t... Casellabelss

17 & How important it is to adopt the digital currency for the economy of India? ...

18 & Which mode of payment do you prefer to pay the most or are comfortable i WLS Weight

19 &4 If cash why? Eg:- Invasion of privacy. avaiding digital trace, easy of paying ... +

. [_ox |

21

22 22| 12-Jun-2022] 12-Jun-2022 anonymous Male | <30 Employed for an hourly wage. Belgaum P 2
23 23 12-Jun-2022  12-Jun-2022 anonymous Female <30 Salaried Employee Bangalore 1 2
24 24| 12-Jun-2022) 12-Jun-2022 anonymous Male 31<40 Salaried Employee Banglore 3 3

11) After choosing the variables, we need to choose the required analysis to be done by ticking
on “R squared” and “Descriptive” to get the desired results as shown in the below image.

)

File Edit View Data Transform  Analyze Graphs Utilities Extensions Window Help

i) A = @ Q
[ e =T A EE 9l
1

f [n] ﬁ Startime o Completio % Email ‘What Whatisyo 5 Pleasestateyouremploymentstat .ﬁ, Inindiawhichcitydoyoubelongto Doyouagreethatpe D
|4

1 : Doyouagreethatpe...

1 Nenand

i 1 }: I;r-nalr\“' T T t,-\ Linear Regression: Statistics had ntly make with digital mone...

4 4 @a What is your gender? [Whatisyourgender] Regression Coefficie Model fit

5 : &k What is your age group? [Whatisyouragegroup] RegrEicEm:

3 ¢ @& Please state your employment status? [Pleasestateyoure | et

7 1 &aInIndia, which city do you belong to? [Inindiawhichcitydoy [ Confidence intenvals DESCHpﬁVEE .

g ¢ & Do you agree that people’s awareness can contribute to t [ Bart and partial comslations | SUT&MCY 1 India can en... |3

9 ¢ & Do you think that govemment policies can impact the laun ] Covariance matrix [ Collinearity diagnastics ¥ in |"'d'3_ can improve th...

10 10 & Do you agree that the introduction of digital currency in In B | e e i

19 4+ 4 Do you agree that the use of digital currency in India can i Readunte -

12 1 & Do you think that the launch of digital currency can increa; [] Durbin-Watson

13 17 & How do you think that the people of India will accept digita] [ Casewise diagnostics

14 14 & How do you think small towns in India will perceive digital ® Rule

15 1t & How safe do you think digital currency would be for carryin

16 4¢ & Do you think the government should make strict laws for g o

17 47 & How important it is to adopt the digital currency for the ec

18 1 & Which mode of payment do you prefer to pay the most or

19 4¢ &k I cash why? Eg- Invasion of privacy, avoiding digital trace——wr

20 A Paste || Reset H Cancel H Help |

21 2

22 22 12-Jun-2022° 12-Jun-2022 anonymous Male <30 Employed for an hourly wage Belgaum 2

23 23 12-Jun-2022  12-Jun-2022 anonymous Female =30 Salaried Employee Bangalore 1

24 24 12-Jun-2022  12-Jun-2022 anonymous Male 31 =40 Salaried Employee Banglore 3
<

Data View Variable View
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12) Select the below criteria in the options as shown in the below image and click on
“Continue” and click “Ok” to get the results.

& Rohit_

File  Edit

He @ e~

av [DataSetl] - IBM Sl

cs Data Editor

View Data Transform  Analyze Graphs Utilities Extensions

=T AE

Window

Help

w4 @ e Q

1 : Doyouagreethatpe |1

& In} ﬁ Starttime Completio & Email ‘Whai Whatisyo

o Pleasestateyouremploymentstat

Inindiawhichcitydoyoubelongto

Doyouaareethatpe

{@ Linear Regression

5 1 Dependent: 3
P ~ . A - . L
: e Linear Regressien: Options > lyou currently make with digital mons
. ” b
4 + &4 What is your gender? [Whatisyourgender] Stepping Method Criteria |
5 ¢ @4 What is your age group? [Whatisyouragegroup] = 3
@ Use probability of F k
6 ¢ &4 Please state your employment status? [Pleasestateyoure. .. - .
7 1 &4 InIndia. which city do you belong to? [Inindiawhichcitydoy. .. Entry: | 05 Removal: | 10 ) } I
8 ¢ & Do you agree that people’s awareness can contribute to th.. O Use F value of digital currency in India can en... ~ I
) ¢ & Do you think that government policies can impact the laun___ Entry: |3.84 Removal: |2.71 fcurrency in ‘"d‘é can improve th. . O |
10 1t 4 Do you agree that the introduction of digital currency in Ind... hd FIETEY o LIEEEE FIEE I |
19 1+ ¢ Do you agree that the use of digital currency in India can i... [ Include constant in equation Enter - |
12 17 ¢ Do you think that the launch of digital currency can increa Missing Values
13 12 & How do you think that the people of India will accept digital... @® Exclude cases listwise |
14 44 ¢ How do you think small towns in India will perceive digital O Exclude cases painwise Rule . |
15 1t ¢ How safe do you think digital currency would be for carryin... i
16 1t & Do you think the government should make strict laws for p.__ O Replace with mean |
17 1 f How important it is to adopt the digital currency for the eco... " I
13 16 & Which mode of payment do you prefer to pay the most or Sontey |
19 10 &alf cash why? Eg:- Invasion of privacy, avoiding digital trace. . ~ 7% |
20 2 |
oK Paste H Resst H Cancel” Help | I
21 2]
22 227 12-Jun-2022] 12-Jun-2022 anonymous |Male <30 [Employed for an hourly wage [Belgaum T 2
23 23 12-Jun-2022  12-Jun-2022 anonymous Female <30 Salaried Employee Bangalore 1
24 24 12-Jun-2022  12-Jun-2022 anonymous Male 31 =40 Salaried Employee Banglore 3
<[]
Data View Variable View
L Y L [N

13) New window will open with the results
coefficients.

T8 "Output! [Document1)] - IBM SPSS Statistics Viewes
Fie Edt Vew Data Tanslrm Insen Format Analyze Graphs (Nities Extensions Wodow Help

HER MM e RELY =» HEQ

8 {§ ouput . All Tequested variables entered
& Rogression
@ e
@ Notes Model Summary
{9 Descnptive Statst chiigé s
Correl: v
oo 4R W Erorofthe  RSquars
{8 Variaties Exlora Modst R RSquare a Esfimate Changs _ FCnangs ot
L Model Summary ;
+ (9 ANOVA [ 380 144 122 887 44 638
(@ Coemcleats. 2 Predctors (Constant, Do you Bink that e launch of digital currency can increase costs for an indivic
(Eg. Tt cost, etc ). Do PONCIOS Can IMpac
inIndia?, Do you agree that the introducson India can snhance the
thatpeople's awareness can contribute 0 he success of the launch of digital currency i India?, Doy
currzney I India can improvs the speed of financial ransacsons?
ANOVA®
Sum of
Moge Squares o eansguwe  F sig
1 Regrassion 25.095 s 5019 6.378 <001®
Residual 18721 189 767
Total 173815 184
a.Dep: of payments win digral
»  monep
b. Pregictors: (Canstant, Do you Sink that ;e launch of digital currency can increase
costs for an inwidual?
4 tion cost, Basic Inrastruchure cost, efc), Do you think
policias can impacte launch of digial currency in ndia?. Do you agree thathe
digital curre othe nancial acivies?.
Do you agres that people’s awareness can contnbute to e success of the launch of
digtal currency in India?, Do you agres that he uss of digeal currency in India can
improve the speed of gnancial vansactions?
< > =

by giving us a model summary, ANOVA and

R “Output! [Document1] - IEM SPSS Statstis Viewer
Fle Edt View Data Tansfom [nsen  Fomat Analyze Graphs  Lilties

HER M e~ FFEL] =6

Extensions  Window  Help

[ Q

B E ouput
- [ Regression
B e
€ Notes
@ Descriptve Stabist
@ comsianons
(@ Vananies Enterea

Coefficients”
Standardized
Unstandarazsd Costicients  Coemciants
Madal 8 St Eiror Bota i

(Constant) 2741 304 9003
Do you agres that people’s - 195 087 155 2007
awarzness can conbibule

o the success o he

Taunch of digital currencyin

Insa?

Do you think that 15 083 126
govEMMENt palicies tan

impact ma launch of digdal

cunancy in india?

Do you agres that the -107 078 =111
niraduction of digital

cunencyin india can

anhance the security of

financial actnes?

Do you agras that he use B 081 148
of digatal curency in Inala

can impreve the speed of

financial ransactions?

Do you think that e launch 188 or2 181
of igetal cumency can

Increase casts or an

indiidual?

(& Model Summary 1

L ANOUA
(8 Coefictents

1807

1408

1883

2354

(Eg; Transaction cost,
Basic Infrasiiucture cosl,
ete)

182

61

What pe with digital money?
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“Analyze” on the toolbar, select “Regression” and click on “Linear”
In the “Linear Regression” window, we need to select the dependent variable and
independent variables as per our research analysis. In our case, the dependent variable is
“Percentage of payments” and independent variables are “Accept Digital Currency”,
“Small town perceive”, “Safe Transaction” and “Strict laws”. Since the Statistics and
options are already selected. Click on “Ok™ to run the results. New window will open by

displaying the desired results.

14) Regression 2 - In order to perform the regression on the survey data, we need to click

File Edit Wiew Data Transform Analyze Graphs Utilities Extensions Window Help
= o g = ﬁ @ R = A
H = 3 = A E|F
1: Doyouagreethatpe... |1
& D &8 Starttime Completio g Email Whai __ Whatisyo nploymentstat & ongto Doyouagreethatpe
43 Linear Regression X
1 ,
Dependent:
2 s e e
3 E Email o ! - = & What percentage of payments do you currently make with digital mene....
4 &a What is your gender? [Whatisyourgender] Block 10of 1
5 &4 What is your age group? [Whatisyouragegroup] Previous
& &4 Please state your employment status? [Pleasestateyoure. . -
7 &4 In India, which city do you belong to? [Inindiawhichcitydoy. Block 10of 1
‘ 4 How do you think small towns in India will perceive digital currency? . ~
8 & Do you agree that people’s awareness can contribute to th... . 5
& How safe do you think digital currency would be for carrying out fina...
g & Do you think that government policies can impact the laun__ Do e s ‘ = ‘
10 10 ¢ Do you agree that the introduction of digital currency in Ind... culnios:e/goverment{should/makelstrctisvisiiogperplelmess
1 11 & Do you agree that the use of digital currency in India can i Method: Enfar o
12 11 ¢ Do you think that the launch of digital currency can increa... -
13 17 & How do you think that the people of India will accept digital - Selection Variable:
14 1 & How do 'you think small towns in India will perceive digital ... - Rule
15 11 ¢ How safe do you think digital currency would be for carryin. -
16 1 & Do you think the government should make strict laws for p... - Ezzplelizs
17 17 & How important it is to adopt the digital currency for the eco...
13 18 & Which mode of payment do you prefer to pay the mast or WLS Weight:
19 10 &4 lfcash why? Eg:- Invasion of privacy, avoiding digital trace... ~ -
20 2
0K
&z : [ox ]
22 220 12-Jun-2022°  12-Jun-2022 anonymous Male =30 Employed for an hourly wage. Belgaum 2
23 23 12-Jun-2022  12-Jun-2022 anonymous Female <30 Salaried Employee Bangalore 1
24 240 12.mn2127] 19 1n9n99 ananumnne Mala 21 =40 Qalariad Fmnlnvaa Rannlnra 2
Wﬁ: *Qutputd [Document3] - IBM SPSS Statistics Viewer
File Edit View Data Transform  Insert Format  Analyze  Graphs Ltilities Extensions ~ Window  Help
i T e & g i i ? S Q
Hala ¢ | ] E
E+ {E] Output
&+ {&] Rearession Model Summary
Title Change Statistics
Notes Adjusted R Std. Error of the R Square
g Descriptive Statist Model R R Square Square Estimate Change F Change dff df2 Sig. F Change
Correlations
1 3427 17 099 .899 A17 6.310 4 190 <001

- Coefficients

(& variables Entered

L& Model Summary
L& AMovA

ANOVA®
Sum of
Model Squares df Mean Square F Sig
1 Regression 20,383 5.096 6.310 <001°
Residual 153432 190 .08
Total 173815 194

money?

India will accept digital currency?

a. DependentVariable: What percentage of payments do you currently make with digital

b Predictors: (Constant), Do you think the government should make strict laws for
people misusing the platform of digital currency mode?, How do you think small
towns in India will perceive digital currency? | How safe do you think digital currency
would be for carrying out financial transactions?, How do you think that the people of

Coefficients”

Standardized

Unstandardized Coefflicients GCoeflicients
Model B Std. Error Beta t Sig.
1 (Constant) 3677 276 13317 <001
How do you think that the -.267 106 -.200 -2512 013
people of India will accept
< > digital currency?

a. Predictors: (Constant), Do you think the government should make strict laws for people misusing the platform of digital currency
mode?, How do you think small towns in India will perceive digital currency? , How safe do you think digital currency would be for
carrying outfinancial transactions?, How do you think that the people of India will accept digital currency?
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15) In order to perform Chi-square Test, click on “Analyze” -> “Descriptive Statistic” ->
select “Crosstabs”.

File Edit VMew Data Transform  Analyze Graphs  Utilities Extensions  Window  Help

= [9] G Paower Analysis > Emﬂ Al

= ==L 4

Meta Analysis ke
Reports >
‘g& D Starttime Ct o — Diln i mmdm b isma e s s n e b ek 9&
b= Descriptive Statistics > [E Erequencies...
Bayesian Statistics > -
1 1 12-Jun-2022  12-J v [£] Descriptives... taka
>
2 2 12-Jun-2022  12-J e [E3] Population Descriptives abad
3 3 12-Jun-2022 12-1J  Compare Means > A, Explore
4 4 12-Jun-2022  12-1  General Linear Model > E; .
. - _ Crosstabs...
s 5| 12.un-2022| 12-] Generalized Linear Models > Hm
B 6 12-Jun-2022 12 . 3 TURF Analysis um
7 7 12-un2022 12y  Mixed Models i’ Ratio um
-Jun- - e — ilore
8 8 12-lun-2022  12-J Correlate > |
9 9 12.un-2022 12 Regression ,  [Ed Proportion Confidence Intervals
e > merr. -
_Jun- - um
Q-Q Plots. ..
12 12 12un2022 124  'Neural Networks > Ea b
13 13 12-Jun2022 12-)  Classify > elf-employed Pune

16) In the crosstabs window, select “Percentage of payments” in rows and in columns “the
importance of adoption” and in the Statistics, select “Chi-square”. Leave the rest of the
settings to default. Click continue and “Ok” to get the results.

ew Data Transform Analyze Graphs Utilities Extensions Window Help

=0 AW A BE 3

[8] Q

[ &2 Startime Completio g4 Email Whal  Whatisyo & Pleasestateyouremploymentstat &4 Inindiawhichcitydoyoubelongto Dayot
= ptime &4 sy &4 uragegro 9@ us & ople's
urge u anconi
4| 49 monoal  an we annolansnusaus [Camain 94 an Lontasiad Conntauan \menntala
2 | @
3
4 Row(s):
5 £ ~ & What percentage of payments do you currently make w...
5 ﬁ Start time [Starttime]
7 42 Completion time [Complstiontime]
g @ Email Column(s):
9 &4 What is your gender? [Whatisyourgender] & How important it is to adopt the digital currency for the _..
at is your age grou atisyouragegrou
10 ia What is your age group? [Whatisyouragegroup] ®
Please state your employment status? [Pleasestatey. .- <l Crosstabs: Statistics X
11 da . Y Py ; o .y Layer 1 of 1
12 &4 In India, which city do you belong to? [Inlndiawhichcit. . - e
12 ¢ Do you agree that people's awareness can contribute .. Previous [MChi-square i[] Correlations
o you think that goverment policies can impact the ... g
14 & Da you think that g it pol pact th MNominal Ordinal
o you agree that the introduction of digital currency i
15 # Do you agre that th duction of digital yi [] Contingency coefficient  [] Gamma
15 & Do you agres that the use of digital currency in India - i - )
17 4 Do you think that the launch of digital currency canin._. [JBhi and Cramer's V [ Somers’d
18 . = [] Lambda [] Kendall's teu-b
19| [ Display clustered bar charts [J Uncertainty coefiicient ] Kendall's tau-c
20 -
o [ Suppress tables Nominal by Interval [ Kappa
22 [k [JRisk
e —— [ MeNemar L
24 12-Jun-2022  12-Jun-2022 anonymous Male 31 =40 Salaried Employ
D Cochran's and Mantel-Haenszel statistics
ariable View
Cr .
Processor is ready &
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17) The Chi-square test appears in the new window as shown below.

ﬂ'ﬁ? *Qutputb [Documentt] - IBM SPSS Statistics Viewer
File Edit Mew Data Transform |Inset Format  Analyze Graphs  Utilities Extensions Window  Help

Hal & 0@ RELS =» HE Q

&+ ] output Case Processing Summary
Cases
Walid Missing Total
@ Case Processing { N Percent N Percent M Percent
L What percentage o What percentage of 195 1000% 0 0.0% 195 100.0%

L& chi-square Tests payments do you currently
make with digital money? *
How important itis to adopt
the digital currency for the
economy of India?

What percentage of payments do you currently make with digital meney? *How importantitis
to adopt the digital currency for the economy of India? Crosstabulation

Count
How important it is to adopt the digital currency for the economy of
India?
1 2 3 4 Total
What percentage of 1 8 14 13 3 38
payments do you currently
make with digital money? 2 u 18 § ! 33
3 51 40 8 0 99
4 15 8 2 0 25
Total a5 78 28 4 185
Chi-Square Tests
Asymptotic
Significance
Walue df (2-sided)
Pearson Chi-Square 321772 9 =.001
Likelihood Ratio 30.604 El <.001
Linear-by-Linear 25971 1 =001

< > Association

18) For the Variance test — click on “Analyze” -> “Compare Means” -> select “One-way
ANOVA”.

t,-\ Rohit_SP55.sav [DataSet1] - IBM SP5S Statistics Data Editor

File Edit Miew Data Transform Analyze Graphs  Utilities Extensions  Window  Help

[2] g Power Analysis > %E .1|i: {_}II‘ O\

Meta Analysis >
= Reports >
é) |n} £ Starttime Pleasestateyouremploymentstat % Inindiawhichcitydoyouk

Descriptive Statistics > ha us

Bayesian Statistics >
1 1 12-Jun-2022  12- alaried Employee Karnataka
2 2 12Jun2022 12 oDles > alaried Emplayee Hyderabad
3 3 12-Jun-2022 12-J  Compare Means > [ Means. .
4 4 12-Jun-2022 12-)  General Linear Model » One-Sample T Test...
2 5 12:un-2022 12 Goperalized Linear Models >
6 5 12-Jun-2022  12-J = Independent-Samples T Test...

Mixed Models >
7 7| 12-Jun-2022 12-) = EZ Summary Independent-Samples T Test
8 8 12-Jun-2022 121 Cormelate 2

Paired-Samples T Test...
9 9 12Jun-2022 12-0  Regression >
10 100 12-Jun-2022  12-J . s [ One-Way ANOVA .
1 11 12-Jun-2022  12-1 Loglinear E
~H & One-Sample Proportions...

12 12| 12Jun2022 124  eural Networks > _
13 13 12-0un-2022  12-1 Classify s kil Independent-Samples Proportions._.
14 14 12-Jun-2022  12-1 Dimension Reduction » Paired-Samples Proportions...
15 15 12-Jun-2022 12-1 Scale s alaried Employee Amravati
16 16 12-Jun-2022  12- - . alaried Employee Mashik
17 17 12-lun-2022 12-3  Monparametric Tests > Jlaried Employee Dharwad
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19) On the One-way ANOVA window choose the variables “Acceptance”, “Perceive”,
“Impact of government policies”, and “Increase cost” as the dependent list. Choose factor
as “Percentage of payments” as shown in the below image.

Transform  Analyze Graphs  Utilities Extensions  Window  Help

ERIFEF A BE J0EQ

arttime % Completio 5‘;'3 Email Whal Whatisyo 9 Pleasestateyouremploymentstat é)a Inindiawhichcitydoyoubelongto Doyouagreethatpe Doy

ntime &4 isyo &4 uragegro A us & ople'sawarenessc ¢ em
urge up ancontributetothes nimg

n-2022 1 pe

2022 14 G# One-Way ANOVA b

2022 Dependent List:

n-2022 1

2022 1 & D & How do you think that the people of India will accept digital ..

2022 1 42 Start time [Starttime] & How do you think small towns in India will perceive digital ¢

2022 1 Completion time [Completiontime] & Do you think that government policies can impact the launc_..

2022 1 & Do you agree that people’s awareness can contribute to th._. & Do you think that the launch of digital currency can increas. ..

2022 1 & Do you agree that the introduction of digital currency in Indi...

2022 1 & Do you agree that the use of digital currency in India can i_..

2022 1 & How safe do you think digital currency would be for carrying.

2022 1 & Do you think the government should make strict laws for pe

2022 1 & How important it is to adopt the digital currency for the eco._.

2022 1 & Which mode of payment do you prefer to pay the most ora... Eror

n-2022 1 ¥ S What percentage of payments do you currently make with __.

:::EEEE : Estimate effect size for overall tests

n-2022 1 | oK ‘ ‘ Paste || Reset ||Cance\ || Help ‘

n-2022 1

In-2022  12-Jun-2022 anonymous Male 31=40 Salaried Employee Bangalore 2

In-2022  12-Jun-2022 anonymous Male =30 Self-employed Gangavathi 2

n-2022  12-Jun-2022 anonymous Male =30 Employed for an hourly wage Belgaum 2

In-2022  12-Jun-2022 anonymous Female <30 Salaried Employee Bangalare 1

n-2022  12-Jun-2022 anonymous Male 31«40 Salaried Employee Banglore 3

20) On the right side, click “Options” select “Homogeneity of variance test” and leave the rest
settings to default. Click “Continue” and “Ok™.

View Data Transform  Analyze Graphs  Utilities Extensions Window Help

o e N i ‘@ [8] Q

Visi
f D Starttime ﬁ Completio é’ﬂ Email Whal Whatisyo 9 Pleasestateyouremploymentstat 6{1 Inindiawhichcitydoyoubelongto Doyouagreethatpe Doyouthil
ntime & isyo & uragegro = us f uple'sawarenessc& ernmentg
p r— urge. up tr‘ One-Way ANOVA: Options % ancontributetothes nimpactthe
" Jun- S PP PARRSTS—— - L -
2 12-Jun-2022 Statistics
3 12-Jun-2022 D :
escriptive
4 12-Jun-2022) ¢ pLve
5 12-Jun-2022 1% & D [[] Fixed and random effects of India will accept digital .
5 q2-Jun2022 1 Start time [Starttime] Homogeneity of variance test India will perceive digital c...
7 1zunz022 1 Completion time [Completiontime] [ Brewn-Forsythe test icies can impact the launc
8 1zunz022 1 4 Do you agree that peopls’s awareness can contribute to th = w gital currency can increas.
0 q2-Junz022 1 & Do you agree that the introduction of digital currency in Ind [J Welch test
10 12-Jun2022 & Do you agree that Ihe us.e. of digital currency in India CEHII. [] Means plot
1 12-Jun-2022 4 How safe do you think digital currency would be for carryin =
12 12-Jun-2022 & Do you think the government should make strict laws for p Missing Values
13 12-Jun2022 ;? How important it is to adopt the digital currency for the eci ® Exclude cases analysis by analysis
Which mode of payment do you prefer to pay the most or .
14 12-Jun-2022 pay youp pay O Exclude cases listwise
15 12-Jun-2022 ! you currently make with ___
16 12-Jun-2022 1% Confidence Intevals
17 12-0un-2022 1§ Level(%): 095
18 12-Jun-2022 1%
19 12-Jun-2022| 1{ _ | L
20 12-Jun-2022 12-Jun-2022 anonymous Male 31=40 Salaried Employee| 2
21 12-Jun-2022  12-Jun-2022 anonymous Male =30 Self-employed Gangavathi 2
22 12-Jun-2022  12-Jun-2022 anonymous Male <30 Employed for an hourly wage Belgaum 2
23 12-Jun-2022 12-Jun-2022 anonymous Female <30 Salaried Employee Bangalore 1
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21) New window will open displaying the results of ANOVA as shown below. “Test of
Homogeneity of Variances”

e Edit View Data Transform Inset Format Analyze Graphs  Utilities Extensions Window Help
0, ™ L i
HER &M e~ KELS M Q
» €] output
E--{E] Oneway Tests of Homogeneity of Variances
+{E] Title Levene
[ notes Statistic an an Sig.
g Tests ofHomagen | i i hattne | Based on Mean 700 3 191 553
| B aon peopls of India will accept  gageq on wedian 832 3 191 478
L5 ANOVA Effect Sizes digital currency? :
Based on Median and with 832 180.828 478
adjusted df
Based on frimmed mean 653 3 191 582
How do you think small Based on Mean 1.168 3 191 323
fowns in INdia will pETCee  paseq on wedian 1.543 3 191 208
digital currency? N
Based on Median and with 1.543 3 178.832 205
adjusted df
Based on fimmed mean 1.426 3 191 237
Do you think that Based on Mean 378 3 181 768
govemment policiss €an — gageq on Median 274 3 191 B44
impactthe launch of digital
currency in India? Based on Median and with 274 3 161526 844
adjusted df
Based on frimmed mean 212 3 191 888
Do you think thatthe launch  Based on Mean 348 3 191 790
of digital currency can
increase costs for an Based on Median 199 3 191 897
individual?
Based on Median and with 199 3 187788 887
(Eg: Transaction cost, adjusted dr
Basic Infrastructure cost,
aic) Based on timmed mean 350 3 191 789
ANOVA
Sum of
Squares df Mean Square F Sig
How do you think that the. Between Groups 7.889 3 2,630 5.595 001

22)For the “Spearman’s correlation”, click on “Analyze”, correlate - “Bivariate
Correlations” and then select all the relevant variables. Under correlation coefficients select

3

& Rohit 5

‘Spearman” and click “Ok” to get the results.

View Data Transform Analyze Graphs Utilities Extensions Window Help

De~EBLZTF ABE @6 Q

1 Howsafedoyouthin_._ ‘2 |V|s|h\s: 21 of 21 Variables
49 D ﬁ Starttime ﬁ Completio Pa Email ‘Whal Whatisyo Pa F Pa Ir Doyouagreethatpe Doyouthinkthatgov Doyoua
ntime isyo Pauragegru us f ople‘sawarsnsssc& ernmeﬂtpullclssca& infroduc
urge.. up nimpactthelaunch: leurrenc;
1 4 12-Jun-2022  12-Jun-2022 anonymous Female 31 <40 Salaried Employee Karnataka 1 1 ~
2 2 12-Jun-2022  12-Jun-2022 anonymous Male =30 Salaried Employee Hyderabad 2 2
3 3 12-Jun-202: 1 1
HN"2922 1) Bivariate Comelations X
4 4 12-Jun-2022 1 1
: 5 i s : :
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